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Overview of Multi-CAD

About Theorem

Theorem Solutions is a world leader in the field of
Engineering Data Services and Solutions. This
leadership position stems from the quality of our
technology and the people in the company. Quality
comes not only from the skills and commitment of
our staff, but also from the vigorous industrial use of
our technology & services by world leading

customers.

We are proud that the vast majority of the world's leading Automotive, Aerospace, Defence,
Power Generation and Transportation companies and their Supply chains use our products
and services daily. Working closely with our customers, to both fully understand their
requirements and feed their input into our development processes has significantly
contributed to our technology and industry knowledge.

Theorem Solutions is an independent UK headquartered company incorporated in 1990,
with sales and support offices in the UK and USA. Theorem has strong relationships with the
major CAD and PLM vendors, including; Autodesk, Dassault Systemes, ICEM Technologies (a
Dassault company), PTC, SolidWorks, Spatial Technology and Siemens PLM Software. These
relationships enable us to deliver best in class services and solutions to engineering
companies worldwide.
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What is Multi-CAD?

Multi-CAD is one of 6 core Theorem brands which consist of:

3 CADverter
J .\,” Direct translation of 3D data to or from an alternate CAD, Visualization
o ) or Standards Based format

Multi-CAD

Interactive integration of non-native 3D data formats into the native
CAD system

Visualize 3D

Direct translation of 3D data for the purpose of Visualization

Publish 3D

The creation of documents enriched with 3D content

Process Automation

Applications to automate any Data Exchange and collaboration
processes

' r Digital Realities
'\
]

Visualization for Augmented (AR), Mixed (MR) and Virtual (VR) Reality
applications
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The CATIA V5 Multi-CAD Bi-directional NX Translator

The CATIA V5 Multi-CAD to NX translator may be installed on a number of machines each
accessing a central network-floating license.

The CATIA V5 Multi-CAD to NX Translator is a bi-directional direct database converter
between the Dassault Systemes CATIA V5 Modelling Application and the Siemens NX file
format.

It enables the user to convert all forms of 3D Mechanical Design Geometry and Assembly
data, together with system defined attribute information, colour information, between
these two systems. This product is designed for companies using CATIA V5 who have
selected NX to be their main method of collaboration and communication between OEMs
and their customers or suppliers.

The translator can be invoked in either an interactive or batch mode with the command line
interface allowing the conversion process to be integrated into any process oriented
operation. Alternatively the conversion process may be operated by using the Theorem
Unified Interface.
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Primary Product Features

Converts all types of geometry, wire frame, surfaces, trimmed surfaces (faces) and
solid models.

Converts assembly structure between both systems.
Converts attribute data including colour and layer information.
Integrated with the CATIA V5 installation.

The conversion process can be run Interactively, Batch Mode or using the new
Unified Interface

Command line interface allows process integration into any workflow or automated
process.

Uses the Dassault Systems CATIA V5 Multi-CAD APl and Siemens NX API to read and
write the respective data formats.

When writing CATIA V5 data the user is able to configure the derived geometry to be
created in either VISU (CGR), VISU + Snap (CGR + Canonical data to aid positioning)
or CATPart format data.

Primary Product benefits?

Being a direct database converter all pre and post processing is eliminated, saving
time.

Reduce costs due to processing time and increase overall conversion success levels
by filtering input data and focusing the conversion to only those elements required.

Reduce costs and risks associated to accessing the wrong version of data by
integrating the conversion process into a related business processes.

With over 20 years of industrial use Theorem translation products robustness and
quality is well proven, reducing your business risk.

This document will focus specifically on guidance for the use of the Multi-CAD for CATIA V5 —
NX product. Forinformation regarding any of Theorem’s product ranges please contact
sales@theorem.com
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Getting Started

Documentation
A copy of the latest documentation for all Theorem Solutions products can be found on our
web site at:

http://www.theorem.com/Documentation

For each of the Multi-CAD related products there is a specific link that provides user
documentation in the form of PDF and Tutorials. For this product navigate to the Multi-CAD
CATIA V5 — NX section.

Installation Media

The latest copy of each release is specified in the Product Release Document associated with
each specific release. A copy of the current product release notes can be found on the
Theorem Solutions web site at:

http://www.theorem.com/Product-Release-Notes

Simply download the Product Release Document and select the hyperlink within the
document to download the installation media.

For Multi-CAD related products the installation requires 3 CD’s to be installed
1. The Theorem Solution TXX Multi-CAD Platform CD
2. The Theorem Solutions Unified Interface CD
3. The Theorem Solutions Multi-CAD CATIA V5 —NX CD

Alternatively, you can request a copies of the software to be shipped on a physical CD
media. Please contact your sales representative sales@theorem.com to arrange the
shipment of the physical CD media.

Software and License Installation

The software installation and License configuration process is fully defined in a separate
document. Please refer to the document titled “Multi-CAD_CATIAVS5_Installation_Guide” for
complete installation instructions

Running the Product

Once configured and licensed, the product will be ready to be used.

Prior to initially using the translator CATIA V5 must have been launched at least once to
allow the selection of the CATIA V5 licenses to be recorded in the users CATSettings folder.
Once the CATSettings are generated the translator will be able to be executed either
internally or externally to CATIA V5 until the CATSettings are removed. Therefore if you
operate a procedure that programmatically generates the users CATSettings this
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requirement to maintain a reference to existing CATSettings must be considered when using
the product in batch external to the CATIA V5 application.

All specific CATIA V5 environment configuration details are documented in Appendix A of
this document.

Methods of Invoking the CADverter

The CATIA V5 <> NX Multi-CAD CADverters can be invoked with a variety of methods,
these include;
e Interactively from within CATIA V5 using standard CATIA V5 menu options
such as “Insert Existing Component”.
e From the Theorem Graphical User Interface (GUI)
e From a command prompt window using the command line. This mechanism
can be used to automate the translation process as part of any automated
workflow.

Interactive usage within CATIA V5

Starting CATIA V5

In order to use the Theorem CADverter products interactively within the CATIA
application, you must start CATIA V5 with the correct CATEnv environment settings. A
desktop icon and a start menu item are both able to be created during the
installation process to achieve this.

The desktop icon is labelled “Theorem Multi-CAD NX CATIAV5Rnn” (where nn is the
release version (26 for V5-6R2016, 27 for V5-6R2017, 28 for V5-6R2018 & 29 for V5-
6R2019).

The Start menu item is located under the “Start + All programs + CATIA” folder and is
also named “Theorem Multi-CAD NX CATIAV5Rnn”.

“Insert Existing Component”

The CATIA V5 Multi-CAD architecture allows you to invoke the Theorem NX to V5
Multi-CAD translator to import components or assemblies into an active CATIA V5
CATProduct by using the “Insert > Existing Component...” menu item.

Also note that the CATIA associativity (Update Status Checker) mechanism can invoke
the translator execution.

In order for the Theorem translator to be invoked from within CATIA V5, the setting
of the “Preferred Conversion Technology” must be set to “Indirect” on the CATIA V5
Tools > Options > Compatibility > “External Formats” option page.

(See section - Setting Conversion Options in CATIA V5)

Note that this option page is only available if the TXX-THEOREM-MULTICAx GATEWAY
(Theorem Partner) license is available which is provided by the Theorem license
manager. Please see the installation document named “CATIA V5
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MultiCAD_Installation_Guide.pdf” for details.

There are some extra conversion options available to the Theorem User Interface
that are not presented on the CATIA V5 External Formats options page.

One method to allow you to specify additional options to the NX to V5 Multi-CAD
translator is provided by a configuration file that the translator reads during the
conversion process.

The configuration file is named %TS_INST%\data\ug\ug_xcad_opts.txt and contains
information on the various options that can be specified using this method.

On invoking the “Insert Existing Component...” command in CATIA V5, and selecting
a product node for the ‘insert’ operation, you will see the following file selector. The
“NX Files” file type should be selected and a NX “.prt” file chosen.

>

File Selection CV Graphic Binary Format(".gbf)
hsf(*.hsf)
€) -1 b ThisPC » OS(C) » demo » MX » NIST v O Inventor Assemblies(*.iam)
Icem Files (*.icem)
Organize ~ New folder idf files(“.idf)
; FFC*if6)
[ Mame Date modified Ty|IGES models (*.igs)
Inventor Parts(*,ipt)
B Desktop ® nist_cte_01_asme1_mB00_rd.prt 03/12/201417:48  PR|JT files(+jt)

# Downloads @ nist_ctc_01_mass.prt 07/2016 11:31 pr| Tared Ideas Model Files(".mf)
madel (*.model)

A
 Favorites

= Recent places o nist_ctc_02_asmel_rxBO0_rc.prt 610:49 PRINCGM(* NCGM)
3% Dropbox & nist_ctc_03_asme1_nx800_rc.prt 14 19:33 pR| WaveFront OBJ(*.obj)
. SolidEdge Parts(*,
L| Google Drive & nist_ctc_04_asmel_nxB00_rd.prt 04/12/2014 20:45 PR P‘;}; Filzgstf”‘:dbi)(w par)
& nist_ctc_05_asmel_nxB00_rc.prt 29/11/2016 09:0 PR OneSpaceDesign files(*.pkg)
1M This PC ® i . 09/12/2014 03:47 op Ideas package Files(*.pkg)
I Is &2 nist_ctc_05_asmel_nxBOO_rd.prt 09/12/2014 03:4 R ProE Parts(*.prt)
fe Desktop X Parts And Assemblies".p
Documents Creo Parts(*.prt)
ProE Parts(*,prt*)
& Downloads Creo Parts(*prt¥)
W Music SolidEdge Parts(*.psm)
= Pictures :C!SEﬁ_?%gﬂg)
cis 53
B Videos

OneSpaceDesign files(*.sda)
& 0S(C) OneSpaceDesign files{*.sdac)

: OneSpaceDesign files(*.sdp)
4% Anon (\TSC-FTP-SVR) (F:) OneSpaceDesign files(*.sdpc)
£ maeke AUTEORMA SO /N session (*.session)

File name; v | NXParts And Assemblies(*.prt) v

[ Open as read-only Open Cancel

The translation will now proceed and the CATIA V5 representation of the NX
assembly/components will be incorporated in the active CATProduct.

It is worth noting here that CATIA launches and manages a conversion sub-process
that feeds the option page settings into the Theorem Multi-CAD translator via a
temporary file named %$CATTemp%\UGToNavConfigs.txt

This is referenced using the —c <config_file>’ command line option.

The Theorem User Interface allows you to select a CATIA generated configuration file
as described above, but if none is selected, a default configuration file installed with
the Theorem software under %TS_INST%\data\ug\UGToNavConfigs.txt will be used.
For further information on the CATIA V5 Multi-CAD integration methods and
commands see the CATIA Infrastructure Documentation.

The Theorem NX to V5 Multi-CAD translator is also invoked when the CATIA “Update
Status Checker” command determines that a NX part file that was previously
inserted using “Insert Existing Component” has been subsequently modified outside
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of the CATIA environment.

For further information on the usage of the CATIA commands “Insert Existing
Component” and “Update Status Checker”, consult the CATIA Documentation under
headings:
e Mechanical Design - Assembly Design
e Here you will find topics
o “Insert an Existing Component”
o “User Tasks” = “Updating an Assembly”

Visualizing Inserted Annotations
It should be noted that when you perform the “Insert Existing Component”
command with a NX file containing PMI data, you must perform the following
operations to visualise it if the Link Mode used is ‘Visu’ or Visu Snap’

e Activate a workbench supporting FTA operations such as with menu item

“Start > Mechanical Design > Product Functional Tolerancing & Annotation”.
e Use menu “Insert > Visualization > List Annotation Set Switch On/Switch Off”
e Enable the listed Annotation Sets and apply the change.

The CATIA V5 XCAD to NX processing messages, errors and warnings are recorded in
a “log’ file located in the CATIA CATReport directory. The file is named after the
active selected CATIA part/product name. E.g. if the part/product Mypart were
selected, the log file name would be %CATReport%\Mypart.log .

A summary file is also produced which contains key information and the process
completion status information. It is named after then log file with the additional
suffix .summary. (e.g. %CATReport%\Mypart.log.summary).
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From the command line

The Theorem User Interface provides the ability to generate conversion command
lines that are appended to a nominated batch file for subsequent execution.

%TS_INST%\bin\cad_run.cmd <translator_name>
-i <input_file_name>

-0 <output_file_name>

[other options]

This is wrapped in a cmd.exe ‘call’ command to redirect output as follows:-
call <emd> > <screen_and_error_output file> 2>&1

E.g. here isa command line example from a batch file:-

call "C:\Theorem\CAD_23.1_MC5NX_WIN.01\bin\cad_run.cmd"
NX12_CATIA5R29XCAD -i C:\theorem 23.1
testing\CAD_23.1_MC5NX_WIN.01\samples\nx\landing_gear_linkage\
Landing_gear_linkage_assy.prt -o c:\temp\ Landing_gear_linkage_assy.CATProduct
mode_catpart progress_file c:\temp\ Landing_gear_linkage_assy.log > c:\temp\
Landing_gear_linkage_assy.log 2>&1
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NX to CATIA V5 MultiCAD Usage

Setting Conversion Options in CATIA

‘-.

12| Pa

If you have the TXX-THEOREM-MULTICAX license, the following categories of options
will be visible from the CATIA menu - Tools > Options on the Compatibility “External

Formats” page

Others

Ideas®

Visu Format Unit

Preferred Conversion Technology
Link Mode

Preferred Translation Mode

Output of generated data

ProEngineer®

Some of these settings are accessible to the Theorem CATIA V5 to NX Multi-CAD NX
translator when it is run in both interactive and command line (batch) mode.

k]
T( Options

General
@ Display
(/=]
@0 Compatibility
Pz
& Parameters and Measu
Devices and Virtual Re:

Infrastructure

"% Mechanical Design

" Shape

Machining

‘ Digital Mockup

Equipment & Systems

Digital Process for Manufz

ge

Options ?

ENOVIA V6/3DEXPERIENCE | External Formats | Graphics Formats | IGES | IGES 2D | SMARTEAM (CA ¢ | »
Visu Format Unit

Millimeters per unit: | 1,00 E

Preferred Conversion Technology
@ (ndirect O Direct

Link Mode
OVisu O VisuSnap @ CATPart

Preferred Translation Mode
@ Multicad O Translator

Others

'd 3D Annotation

Output of generated data
Output Path : | C:\Users\trevor\AppData\Local\DassaultSys @I

Ideas®
] IDI 3D Annotation

ProEngineer®
[ Quilts Read
[[] Simplified Representation

[ Instance Name

@ OK I QCancdl
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Visu Format Unit

igu Format L nit

illimeters per unit ; |‘| oo E

+ Millimeters per unit

The conversion of units from NX parts is incorporated into the Theorem CADverter,
so this value should always be set to 1.00

Preferred Conversion Technology

Preferred Conversion Technology
@ Indirect O Direct

Indirect

This parameter determines that the 3™ party Theorem converters will be
used in conversion operations.

Direct

This parameter determines that the Dassault Systemes converters will be
used in conversion operations.

Link Mode

Link Mode:
@ Yisu 1 visusnap ) CATPart

Visu

Tesselated data. By default, this option is activated.

Visu Snap

Selecting this option forces the processing of NX precise BREP geometry to
generate a CATIA V5 CGR output. In addition canonical shape properties are
also generated in the CGR file. Consequently the CGR data resulting from
importing NX will have additional geometry snapping capabilities. After
selecting this option, this message appears: "Please, restart session to take
modifications into account".
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CATPart

This option causes the import of exact/brep geometry from the NX file to be
created in CATPart form.

Preferred Translation Mode

Preferred Translation Mode
@ Multicad 2 Translator

Selecting this option controls if links will be retained between the source NX files
which are imported, and the resulting CATIA files generated. In Multi-CAD mode,
links are retained and modifications are locked, in Translator mode, links are not
retained and modifications are allowed.

Others

Save Co-ordinate system in Cgr

This option saves the NX PMI co-ordinate system data into the derived CGR
representation when Visu output is selected. Note this feature would also require
the 3D Annotation setting to be selected to create the required output.

3D Annotation

This parameter determines whether 3D annotation data, referred to as
“PMI” data in NX, will be imported.

(Note, requires one of the following licenses):
CATIA: FT1.prd or FTA.prd
ENOVIA: DT1.prd

DELMIA: MTR.prd or MFT.prd

Output of generated data

Cukput of generated data

Cutput Path ¢ | \Documents and Settings'ajtiLocal Settin @l

Output Path

14| Page

Setting the Output Path location enables you to customize the folder
location that is used when writing the derived CATIA V5 generated data. It
specifies the location where CGR, CATPart and CATProducts will be
generated.
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The NX to CATIA V5 Multi-CAD options file

There are some extra conversion options available in the Theorem CADverter GUI

that are not presented to the user on the CATIA External Formats options page.

A mechanism to allow you to specify additional options to the NX to V5 Multi-CAD
translator is provided via a text file that the translator reads during the conversion
process.

The default location of this options file is defined in
the %TS_INST%\bin\TheoremProps.txt file by the setting:
Theorem.NxServerCfile=%TS_INST%\\data\\ug\\ug_xcad_opts.txt

This text file can be edited to contain any of the following command line options on a
separate line:-

15| Page

info

Outputs extra processing information to log files

debug
Outputs extra debugging information to log files help diagnose
problems.
noprep
This option affects the reading of Parasolid data within the NX file.
By default the brep data is prepared for writing to another system
by steps such as removing small edges, splitting complex faces, and
converting surfaces to NURBS. This option disables this preparation
and uses the original parasolid definition.
rd_native_edge
By default some analytic edge definitions are converted to NURBS
curves. This option forces the use of native analytic edge definitions.
show_axis_system
By default axis systems are created in CATIA hidden visibility space.
This option will create them in the shown visibility space.
read_blank
By default entities which are blanked are not read. This option
allows the reading of blanked entities.
ignore_std_views

By default the translator will read standard views (top,right,front
etc). This option forces these views to be ignores.
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The NX to V5 Progress and Log File Outputs

The NX to CATIA V5 XCAD process log and error messages are recorded in a “log’ file
located in the CATIA CATReport directory. A process summary file is also produced
here which contains the completion status of the conversion. These files are named
after the selected input file name. E.g. if the file Landing_gear_linkage_assy.prt were
selected, the log and summary file names would be %CATReport%\
Landing_gear_linkage_assy.log and %CATReport%\tea.log.summary.

If the NX to CATIA V5 XCAD process is run using the CADVerter GUI or using the
command line option ‘progress_file’ <name>, the log file output will honour this
name, and the summary file will be named similarly with the suffix “summary’.

The V5 to NX Progress and Log File Outputs

The CATIA V5 XCAD to NX process log and error messages are recorded in a “log’ file
located in the CATIA CATReport directory. The file is named after the selected output
file name. E.g. if the file Mypart were selected, the log file names would

be %CATReport%\Mypart.log and %CATReport%\Mypart.log.summary.

If the CATIA V5 XCAD to NX process is run using the CADVerter GUI or using the
command line option ‘progress_file’ <name>, the process log and error messages
will be output to the specified name, and the summary file will also be named after
this name with the suffix *.
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Using the Theorem User Interface

Default Translations
The Unified Interface can be started via the Start Menu — if a shortcut was added during
installation.

Alternatively, the Unified Interface can be run via a Windows Explorer selection in:
<Ul_installation_directory>\bin\Unified_Interface.cmd

The following interface will be launched:

orem Solutions Unified Interface = ==
Home ]
w BEEB08 » | E T
0 Preset  Custom Horizontal File | |Translator Translstor |Configuration |Translator | | Product | Viewer | Event
Layouts - Layouts - Split Browser| | Activity | Batch | Manag logs | |Structure Viewer
& Translator Activity ¥ File Browser ¥ B X | D Batchoff N
R
= @ % @ x & v Vieww . Al g
= ‘ Citheorem 193 testing\CAD_18.3_MCSNX_WIN.01\sample [f ] Options ¥ View Filter: @ CATIA VSR23 Xéﬂ[ g
D Action Wodel Name System Configuration Date z lorme e e Dote Modifi A
. || [B D=sktor = N S= _[Typs Date Modifed FEmisimE o s
o 283 Direct Rear_Suspension  CATIASR2GXCAD to <default> 01/09/2016 08:44 - A MyComputer ) rist_ctc_01_asmel_ m@00_rdprt 1352K8 UG
o 24 Direct pump_assy CATIASR26KCAD to <default> 01/09/2016 08:44 « &L Windows (€) ) rist_ctc_02_ssmelo800_rcprt 05 NXLO -
o 285 Direct pump_assy CATIASR26XCAD to  <default 01/09/2016 0845 b $Recycledin 8 nist_ctc.03_asmeL_nxB00_rcprt UG <default> B
: 285 Direct Rear_Suspension  CATIASR26XCAD to  <default> 01/09/2016 08:45 Y @ cad_apps it _cte.04_ssmeL 00 sdprt T
287 Direct nist_ctc_01_asme_ct CATIASRZ6KCAD to  <default> 01/09/2016 0845 } (21 Documents and Setting 5 4
o 288 Direct nist_ctc_02_asmel_ct CATIASR26XCAD to  <default> 01/09/2016 08:45 2 || St 0s gsmet a0 rapn e @ CATIA V5R24 Xéﬂ[
e - P Intel || NIST_MBE_Mode!_Disclaimer.tet 1KB Tex
o 289 Direct nist_ctc_03_asme_ct CATIASR2GKCAD to  <default 01/09/2016 0845 H > Jeve @ TS
200 Direct it cte_04_asmel ct CATIASR26XCAD to  <default 01/00/2016 0845
4 ireet nist_ctc_04_asmel o <default> /097 » )l Perilogs ] =
o 21 Direct nist_ctc_05_asme_ct CATIASR2GXCAD to  <default> 01/00/2016 0845 » L Program Files
o 292 Direct nist_ctc 01 asmel_ct CATIASR2GKCAD to_<defaut> 01/09/2016 0845~ » L Program Files (x86)  |=. ey =
»  Progrembata x
5 Transator Logs ¥ | Tae Product Structure - [ ] Confguration Manager w- | o RPKEsols @ CATIA V5R25 XCAL =
b System Volume Inform -
Activity[291: nist_cke_05_ssmel_ct + | Transiation:(CADverter ~ | Loge(Options = | [ Options v e From Active Configurations
2 » i Theorem NXLO 2
el M ~ | theorem 19.3 testing <default> -
Name Description Setting ~ ) CAD_19.3 MCSNX_

[ - é\ﬂ
confirm Create file containing exit code ON L » 0 B2 CATIA V5R26 XCAL
concat_assy Assy toplevel name NOT prefixed OFF > lexs | Figiasie e iigusicns

i b B2 NX10. E
delete_parts Delete existing assembly parts oN » @ b
(el sl Produce UG facetted solids oN - b Ul date <defeult> -

B
Heal UG bodies Tolerance for healing 0.0095 et e

> U guides & o
keep bodies Remove any extra sewn bodies OFF b 1L INSTALL ]

From Active Configurations
nocheck Suppress Parasolid Checking ON bl Java

™ (CATIA VSR26 XCAL »
fix small feat Don't fix small features in solid OFF (default) (")

v L samples <default> -
fix opensolid Don't fix opensolids OFF (default) b L catias o

R F—— A
pstolmodel Tolerant Modelling factor 3 NET  Date emocifec: 01/09/2016 1620 2 es w
no_brep prep Do not prepare brep solids oN = b e oer isa=le e e
Reacy

The default layout is split into 4 primary areas, which can be altered to the users prefer:

Translation Active

Activity

e el il e

Configurations

corcst azy
dele_ports

re ectase]
s [deinit)
3

File
Browser

Output
Logs

oo biso o ___Torer on L

17 |Page ©Theorem Solutions 2020




Multi-CAD v23.1 for CATIA V5 - NX

Theorem
Solutions

The simplest way to translate from CATIA V5 or NX is to drag a file from the file Browser
Pane on to the Active Configurations for the translation you require.

. 193 testing\CAD_lQ.B.MCSNI 4 | Options v  View v  Filter: |All Files (%) ~

) TEMP
J Theorem
J theorem 19.3 test

, CAD_19.3_MC
B23

B24

B25

B26

bin

data

- v v w v v w =

| &
| &
| &
| &
| &
| B
B etc

. guides
TALL

"

B ..

| <getaul-

MName
@ nist_ctc_01_asmel ct5210_rd.C
@ nist_ctc_02_asmel_ct5210_rc.CA
@ nist_ctc_03_asmel_ct5210_rc.CA
@ nist_ctc_04_asmel ct5210_rd.C2
48| nist_ctc_05_asme1_ct5210_rd.C2
| NIST_MBE_Model_Disclaimer.txt

Size  Type Date Mod @ CATIA VSR26 X&l
1.047 KB CA" 14/06/2016
3 C 4/06/2016 From Active Configurations
1173KB  CAN14/06/2 |NX10 v
2223KB C | <default> - |
1299KB C
1KB Tex 14/06/2016 Y

& nxao

From Active Configurations

e
| CATIA VSR26 XCAL ~ |

‘ <default>

—

On completion, the Unified Interface will display the activity information and details from
the log file created during the translation, if requested, in the Translation Activity and
Output Log panes, respectively.

The generated output data can be located by selecting the translation from the Activity pane
and opening the output folder:

_aon

Direct

-« @ x &l L. CAThec.
Model Name System Configuratior Date 7 o
> 8.2_CASNX_WIN64.01
nist_ctc_01_asn CATIAS24 to I <default> AOEENIES LS
{54 View The Log
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] Transiation:iCADver v J Log:LSummari

X000 FERRFFHE

nt from

defined in general environme =l

View the Input File Product Structure

View the Output File Product Structure
Open output folder in File Explorer
Create an Audit Trail Package

Re-process the translation

glected translations

Re-run all selected translations

Delete all selected translations

Properties

g21\bin\..\ts_env.bat
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NX to V5 translations using the Command Line

To run the translator from the command line you must ensure that the CATIA V5
environment is set correctly. The easiest method to achieve this is to use the standard CATIA
start-up process. This uses the following syntax;

%V5_INSTALL_PATH%\win_b64\code\bin\CATSTART.exe

-run "%TS_INST%\B%V5_VER%\win_b64\code\bin\UGToNav.exe
%COMMAND_LINE_ARGUMENTS%"

-env Theorem_Multi-CAD_NX90_ CATIAV5R%V5_VER%

-direnv "%TS_INST%\B%V5_VER%\win_b64\CATEnv"

Where;

%V5_INSTALL_PATH% = the path to the CATIA V5 installation e.g C:\Program Files\Dassault
Systems\v5r29\B29

%TS_INST% = the path to the Theorem Solutions installation e.g.
C:\Theorem\CAD_23.1_MC5NX_WIN.01

%V5_VER% = the version of CATIA V5 that is being used e.g. 27, 28 or 29
%COMMAND_LINE_ARGUMENTS% = these will depend upon the type of Link Mode data
type that you want to create in the output e.g. VISU, VISU+SNAP or CATPart

Link Mode = Visu

5T
T( - ENOVIA V6/3DEXPERIENCE | Extemal Formats | Graphics Formats | 1GES | IGES2D | SMARTEAM (CAD |SM 4| »
Visu Format Unit
General Millimeters per unit : | 111])] =
@ Display Preferred Conversion Technology

[nl=) @ Indirect (' Direct
@0 Compatibility
Link Made

P
% Parameters and Measure @ Visu O VisuSnap O CATPart

Devices and Virtual Reali  preferred Translation Mode

@ Multicad O Translator
Infrastructure

Others
Mechanical Desi
sehanieaibesian [ save Coarsys in Cgr

Shape < 3D Annotation

Tig

Command Line Arguments
-c %TS_INST%\data\ug\UGToNavConfigs.txt
-i <input_NX_filename>
-oproduct <output_CATProduct_filename>
-d <path_to_output_folder>

read_pmi - optional argument to process NX PMI data. Note this requires access to
a V5 FTA license
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e.g — %TS_INST%\data\ug\UGToNavConfigs_VISU.txt —i %TS_INST%\samples\ug\NIST\
nist_ctc_01_asmel_ct5210 rd.prt —oproduct C:\temp\NIST_01.CATProduct —d C:\temp
read_pmi

Default Translation — via the Alternate Command Line Interface

Running a translation via the alternate command line can be carried out via the
cad_run.cmd file located in the <installation_directory>\bin directory. The format of the
command is as follows when translating from CATIA V5 to NX:

<Translator_installation_directory>\bin\cad_run.cmd CATIASR[XX]XCAD_NX[YY] —i
<input_file> -o <output_file>

The format of the command is as follows when translating from NX to CATIA V5:

<Translator_installation_directory>\bin\cad_run.cmd NX[YY]_CATIA5R[XX]XCAD —i
<input_file> -o <output_file>

(Note! Replace the [XX] seen in the example with the version of CATIA V5 you are using. E.g.
for CATIA V5 R29, change to 29

Replace the [YY] seen in the example with the version of NX you are using. E.g. for Siemens
NX 1847, change to 1847):

B CAWindows\system32\cmd.exe ||:| El |-

c:“Users>"C:\Program FilessTheorem~22._.1_MC5_HNE“bin“cad_run.cmd' NXZ1847_CATIASRZ29XCAD —-i "C:“Program

Files“Theorem~22.1_MC5_HNX¥>szamplessnx*NISTwnist_ctc_@1_asmel_nx80@_rd.prt" —o C:-“\TEMP~MNi=ztl.CATPart

The example above will translate a CATIA sample file provided within the installation and
produce the following screen output:
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c:sUsers>"C:sProgram FilessTheorem~22.1_MC5_HNEsbhinscad_run.cmd" NZ1847_CATIASRZ?2ECAD -i “C:“Program
Files\Theorem~22 _1_MC5_HEszamplessnx“NISTsnist_ctc_B1_asmel_nxBB@_wd.prt'" —o C:STEMP“Nistl .CATPart
Warning TS_INST defined in general enviroment
Sourcing Theorem Enviroment from -

:wProgram FilessTheorem~22.1_MC5_HNX>hin~..~ts_env._ hat
Using CATIA environment file C:“Program Filez“Theorem~22_1_MC5_HN2“\B29 win_b64*\CATEnusTheorem_Multi—
EH?_N31847_CRTIRU5R29.txt

)
b
W

R e e e S e R R R R R R

# Copyright Theorem Solutions Limited =
=* Ni - CADverter Uersion 22.1.881 *
o oS- JuE-JuE- oS- Se-E-JaE- o oo Sef-E-JuE- - oo Sef-E-JuE- - oSS o oS- oo o
CATIA Runtime Version is B292

Start Time Thu Jun 6 B7:88:24 2819

CATReport dirvectory: C:sUserssldavizonsAppDatasLocalsDassaultSystemes“\CATReport
Using default CATIA config file —c GC:“Program Files:Theorem~22.1_HC5_HNa-~data~ug~UGToNavGonfig

WA A AN AR
e e L L e L L L
R R A

~
—
b

Input File : C:“Program Filez“\Theorem*~22_1_MCLHi_HNH“zamplessnx“NISTwnist_ctc_B1_asmel_ nxBEA_wd.

Output File : G:STEMPWNistl . CATPart
Translation Mode is set to MultiCAD
<I> CADuert process is active
<I> CADvert process is active
<I> CADuert process is active
GCO API Log File : CislserssldavisonsApplatasLocalsTempsUg_read_pid3?88. log

000000000 0000000 -0 e oo e oo e oo e oo e oo oo
# Copyright Theorem Solutions Limited *

=* llg — CATIA Multi-CAD CADverter Uersion 22.1.081 =
oot S-S -oE- oo et SeE-E-oE- oo Jef e -0E-eE-JuE- o Jef el -E-uE-JuE- o Jef el E-eE- oo e Sef - oo e Sef - e Sef e
Thu Jun 6 B9:85:25 2819

Input
lly File C:~Program Files~Theorem~22.1_MHC5_HNZszamplessnx~MIST nist_ctc_B1_asmel_nx800_»rd.

CATIA File C:~TEMP~Nist1.CATPart
Progress File

Curves
Surfaces
Planes

Faces

Edges
Uertices
Bsolids

fixis systems

End Time Thu Jun 6 B9:85:35 2819

kT Ea Tt T tata s katatatatadatatatikatiakatiaial
#* Successful Completion =
#® CinTEMP-Hist1l . CATPart =

P R S R T

Thu Jun 6 B9:85:35 20819
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Translator Customization

The Theorem translator allows the information that is read from the source system and
written to the target system to be tailored via a set of user specified arguments. Commonly
used arguments are supported via the Unified Interface, with Advanced Arguments being
described within this document for use in the Unified Interface or via the Command Line
invocation.

Common Options for CATIA V5 to NX

Within the Configuration Manager pane of the Unified Interface, arguments that can be
specified when publishing CATIA V5 data into NX are grouped into 3 areas:
e CATIA V5 Read - Those arguments that affect how data is read from CATIA V5
e NX Write — Those arguments that affect how the data is written to NX

e General —Those arguments that are common to ALL Publishing activities
regardless of source data

CATIA V5 Read Arguments
The image below shows the CATIA V5 Read arguments that are available, with their default
settings:

CATIA V5 XCAD Read | NX Wiite | General |

Option Name Value

Preferred Read Data Type [Exact -

SAG Value

Read 3D Annctations
Disable Points
Disable Axis Systems
Disable Wireframe
Disable Surfaces

Disable Sclids

OO O0DODODOO s

Export Body Names

Each of these options is described below:
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Option

Preferred Read Data Type

SAG Value

Read 3D Annotations

Disable Points

Disable Axis Systems

Disable Wireframe

Disable Surfaces

Disable Solids

Export Body Names
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Description

Allows the user to specify Exact or Tessellated read

e Command Line Syntax
o Exact (Default)

o Tessellated
= read_tess

Edit the SAG value being used (Default 0.2)

e Command Line Syntax
o sag [value]

Read PMI (Default is OFF)
e Command Line Syntax
o read_pmi

Disable the processing of standalone Points (Default is OFF)

e Command Line Syntax
o disable_points

Disable the processing of Axis Systems (Default is OFF)

e Command Line Syntax
o disable_axes

Disable the processing of standalone Wirefarme (Default is
OFF)
e Command Line Syntax
o disable_wireframe

Disable the processing of standalone Surfaces (Default is
OFF)
e Command Line Syntax
o disable_surfaces

Disable the processing of solids (Default is OFF)

e Command Line Syntax
o disable_solids

Create Body Named Containers (Default is OFF)

e Command Line Syntax
o body_names
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NX Write Arguments

The image below shows the Write NX arguments that are available, with their default

settings:

| CATIA WS XCAD Read | MNX Write | General

Option Name Walue
Delete Existing Sub-parts (]
Concatenate Assembly Name (]
Praduce Tessellated Qutput [

These options are described below:

Option

Delete Existing Sub-parts

Concatenate Assembly
Name

Produce Tessellated
Output
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Description

Delete existing sub-parts. Default is OFF.
e Command Line Syntax
o delete_parts

Concatenates assembly name. Default is OFF.
e Command Line Syntax
o concat_assy

Produce Tessellated NX file. Default is OFF

e Command Line Syntax
o tess_output—to turn on
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CATIA V5 to NX General Arguments

The image below shows the General arguments that are available, with their default

settings:
Description:
CATIA W5 XCAD Read | WX Write | General
Cption Name Value
Mass Properties (]
Out-of-range Layers [Map To Layer hd
Layer Mumber 256
Advanced
This option is described below:
Option Description
Mass Properties Allows Mass Property information to be read from the

source data and written as attributes to the PDF document.

Default is OFF.
e Command Line Syntax:
o mprops

Out-of-range Layers How to handle layers from the input system that are out-of-
range in the output system. Default is ‘Map To Layer’

e Command Line Syntax:

o Map To Layer: Default
o Layer Modulus (Cycle): cycle_layer

Layer Number A secondary option used with Out-of-range Layers when
‘Map To Layer’ is selected. Allows the layer number to be

specified. Default is 256.
e Command Line Syntax:
o Base_layer 256

Advanced Allows any of the Command Line Advanced arguments
documented below to be passed to the Unified Interface

invocation
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Common Options for NX to CATIA V5

Within the Configuration Manager pane of the Unified Interface, arguments that can be
specified when publishing NX data into CATIA V5 are grouped into 3 areas:
e NXRead —Those arguments that affect how data is read from NX
e CATIA V5 Write — Those arguments that affect how the data is written to NX
e Entity Mask — Those arguments that allow specific read entities to be masked
e General — Those arguments that are common to ALL Publishing activities

regardless of source data

NX Read Arguments

The image below shows the NX Read arguments that are available, with their default
settings:

MX Read | CATIA VS XCAD Write | Entity Mask | General

Option Name Value
Refersnce Set
Fead Attributes ]
Fead MN¥ names ]
Read PMI O]

Each of these options is described below.
Option Description

Reference Set Enabled reference set processing. Default is OFF
e Command Line Syntax:
o ref_set—toturnon

Read NX Attributes Read NX detail user attributes. Default is OFF.
e Command Line Syntax:
o read_attrs

Read NX Names Read NX entity names, if they exist. Default is OFF.
e Command Line Syntax:
o no_read_name — default
o read_name —to turn on
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Read 3D PMI. Default is OFF.

e Command Line Syntax:
o read_pmi write_stroked pmi

Read PMI

CATIA V5 Write Arguments
The image below shows the CATIA V5 Write arguments that are available, with their default

settings:
NX Read | CATIA V5 XCAD Write | Entity Mask | General |
Opticn Mame Value
Link Mode Selection | CATPart - |
Preferred Translation Mode [Multicad > |
Axis Systems - Show ]|
Property Mapping File E|

Each of these options is described below:

Option Description
Write Visu, Visu Snap or CATPart data.
e Command Line Syntax
o Multicad (Default)
= mode_catpart
o Visu
=  mode_visu

o Visu Snap
= mode_visu_snap

Link Mode Selection

Werite non-editable Multicad or editable Translator data

e Command Line Syntax
o CATPart (Default)
= translator_mode_off

o Translator
= translator_mode_on

Preferred Translation
Mode

Axis Systems set to Show state (Default is Off)
e Command Line Syntax
o show_axis_system

Axis Systems - Show

Specify a file which allows filtering of Detail user attributes.

Default is OFF.
e Command Line Syntax
o cad_prop_map_file [file]

Property Mapping File
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NX to CATIA V5 Entity Masking Arguments
The image below shows the Masking arguments that are available, with their default

settings:

Description:

MNX Read | CATIA V3 XCAD Write | Entity Mask | General

Yalue

Specifies the Mask File to be written to, that can be
referenced by future translations. A Mask file MUST be
specified if masking is required. The first line in this file is

e Command Line Syntax:
o Mask <filename>

Cption Name
hazk File
Option Description
Mask File
OFF ALL ENT:
Entity Types Translated

Layers Translated

28| Page

Specifies a selection list from which to select which entity
types are to be processed. The following types are
available:
"POI","LIN","ARC","CON","CUR","SUR","FAC","SOL"

e Command Line Syntax:

o Add any of the above to the specified mask
file, one entry per line prefixed by the word
ON, e.g.:

ON POI
to ensure they are considered in the
translation
Specifies a selection list from which to select which layers
are to be processed.
e Command Line Syntax:

o Asingle entry of ON ALL LAY Must precede
any Layer Mask command.

o Add a list or range of numbers representing
layer to be processed to the specified mask
file to ensure they are NOT considered in
the translation e.g.: OFF LAY
114,149,166,167,168
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NX to CATIA V5 General Arguments
The image below shows the General arguments that are available, with their default

settings:
Description:
MNX Read | CATIA WS XCAD Write | Entity Mask | General
Option Mame WValue
Advanced

The option is described below:
Option Description

Advanced Allows any of the Command Line Advanced arguments
provided by Theorem Solutions to be passed to the
translator via the Unified Interface invocation

©Theorem Solutions 2020
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Appendix A — CATIA V5 Configuration

Introduction
This Appendix details how to define and configure the CATIA V5 and Theorem environment
to work together.

Conventions

Release of CATIA V5

To indicate a release of CATIA V5 the notation <XX> shall be used. This needs to be replaced
with the specific release to be used i.e. 26, 27, 28 or 29.

Platform specific directory
Within the installation directory of CATIA V5 there is a platform specific directory i.e.
win_b64. This directory shall be referred to as <OSDS> in this Appendix.

Theorem Installation directory
The Theorem translator installation directory is set at installation time in the translator
ts_env.bat file. This directory shall be noted as <%TS_INST%> in this Appendix.

CATIA V5 Installation Directory

Upon installation of a CATIA V5 product the user will be asked to specify the installation
directory. This is the directory which contains the platform specific <OSDS> directory.

Having selected the CATIA V5 installation directory via the browse button, the installation
process will record the location of the CATIA V5 installation directory in the ts_env.bat file.
This file is located in the Theorem translator installation directory. If the location of CATIA V5
subsequently changes, the translator can be guided to the changed location by modifying
this file using a text editor to modify the ts_env.bat that is located in the translator
installation directory.

If no entry is included for DSLICENSING a warning dialog will be displayed which warns of the
empty field. Selecting Yes to continue will allow the installation to continue.

Missing Data BT (e

. The Value of the following Property has not been specified:
¥ DSLICENSING

You can run the configuration utility later, however the
property must be set before using the software.

Do you wish to continue? l

I Yes ] [ No
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Running CATIA V5 Translators

Before running the translator the user must run CATIA V5 interactively at least once to
configure the CATIA V5 environment and license settings. This can be achieved by running
the catia5r<XX>_start script as follows:

%TS_INST%\bin\catia5r<XX>_start.cmd

Once CATIA has been run the Translator can run as described in the relevant product User
Guide.

CATIA V5 Environment DIRENV & ENV

The default location for CATIA V5 to store its global environment files is in the global
directory:

Windows XP:
C:\Documents and Settings\All Users\Application Data\DassaultSystemes\CATEnv

Windows 7 & 8:
C:\ProgramData\DassaultSystemes\CATEnv

Or
%APPDATA%\CATEnv

You can find this location by running:
%CATIAV5_INST%\<0OSDS>\code\bin\setcatenv -h
The environment files are named in the form CATIA.V5RN.B<XX>.txt

If when installing CATIA V5 the default environment file location was replaced with another
location then this location needs to be indicated to the Translator by defining in the
ts_env.bat the environment variable CATIAV5_DIRENV:

set CATIAV5_DIRENV=/some/directory

If the Theorem installation is needed to support multiple releases of CATIA. Then the user
can define release specific locations using:

set CATIAV5R<XX>_DIRENV=/some/directory

The Theorem translator will attempts to create its own environment file called
TheoremCatia5R<XX>.txt. The user must therefore have write permission to the CATEnv
directory. If this is not possible an existing environment file can be specified using the
variable CATIAV5_ENV. e.g.

set CATIAV5_ENV=CATIA.V5R19.B19

Note. the extension .txt is not required. The user can specify a release specific name using
CATIAV5R<XX>_ENV e.g.
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set CATIAV5R19_ENV=CATIA.V5R19.B19

Checking the CATIA V5 Environment
A script is provided to check that the CATIA V5 environment is set up correctly. In a
command window run the command script:

%TS_INST%\bin\checkcatia5r<XX>env.cmd

Checking the Theorem Shared Library
A script is provided to ensure that the CATIA V5 environment is compatible with the
Theorem shared library. Ina command window run the command script:

%TS_INST%\bin\checkcatia5r<XX>cadverter.cmd

A successful output is an indication that the location for CATIA V5 has been specified to the
Theorem translator correctly and that the correct version of the Theorem CATIA V5
translator products have been installed.
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